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CHAPTER ONE 

INTRODUCTION  

1.1  Background  

The Student Industrial Work Experience (SIWES) is the accepted skills training 

programme which form part of the approved minimum academic standard in the various 

degree programme for all the Nigerian Universities and Polytechnics. It is an effort to bridge 

the gap existing between the theory and practice of Engineering, Technology, Science, 

Agriculture, Medical and other professional education programmes in Nigeria Institutions.  

The minimum duration of the SIWES is 16 weeks for Engineering and Technology 

program in the Polytechnic. The Scheme has triple program involving the Student, 

Polytechnic and Industry. The triple program is well recognized throughout Nigeria.  

It is found by the Federal Government of Nigeria and jointly coordinated by the 

Industrial Training Fund (ITF) and the National Association of Universities, Polytechnic 

and Technical Schools. The major important factor that makes the Federal Government of 

Nigeria to establish Student Industrial Work Experience Scheme is the development of 

students brain toward what they have been taught in the school i.e the practical aspect.  

1.2  History of student industrial work experience scheme  

SIWES was established by Industrial Training Fund in 1997 to solve the problem of 

inadequate practical knowledge by Nigerian Graduates of Tertiary Institutions.  

The Scheme exposes students to industrial based skills necessary for a smooth 

transition from theory to practical and also its affords students of tertiary institutions the 

opportunity of being familiarized and exposed to the needed experience in education 

institutions. Participation in SIWES has become a necessary precondition for award of 

diploma and degree certificate in specific discipline in most institutions of higher learning 

in Nigeria, in accordance with the education policy of government.  

1.3  The Objectives of SIWES  

  The objectives of the Industrial Work Experience Scheme are to:-  



(i) Prepare the students for the work situation that they likely to meet after 

graduation or nearest in the future.  

(ii) Provide and avenue for students in the Nigeria Universities, Polytechnics 

and Technical Schools to transfer theoretical knowledge to practical skills.  

(iii) Create room for student to apply the theoretical knowledge which has been 

promote the technological development and passed from the teacher to the 

student to the practical work.  

(iv) Enlist and strengthen employer’s involvement in the education process of 

preparing Universities, Polytechnic and Technical School graduates for 

employment in industry.  

(v) Familiar students with work methods and machinery that may not be 

available in the schools which will help students in machineries and 

equipment handling.  

  



CHAPTER TWO 

2.1 Historical background of the study 

      T noble information technology located at kwara state polytechnic westend established in year 

2015, own by Mr tunde 

2.2 Section of the Organization 

  I. Photocopy  

Ii.  Computer type setting  

Iii.  Networking   

 

 

  



CHAPTER THREE 

3.1 EXPERIENCE GAINED 

How to Boot A Computer 

To boot a computer, you can turn it on by pressing the power button. The exact location of the 

power button depends on the model of your computer.  

Steps to boot a computer  

1. Turn on the computer's power 

2. Wait for the computer to finish booting 

3. Enter your username and password when prompted 

Entering BIOS 

You can also enter BIOS setup by restarting your computer and pressing a specific key during the 

boot process. The key you need to press depends on the manufacturer of your computer, but it's 

usually one of the following: F1, F2, F10, DEL, and ESC.  

Types of booting 

There are two types of booting:  

 Cold booting: Starting a computer after it's been turned off 

 Warm booting: Restarting the operating system after a system crash or freeze 

You can also watch this video to learn how to boot a computer from a CD or DVD: 

 



Windows is a graphical user interface (GUI) operating system developed by Microsoft, allowing 

users to interact with their computer through visual elements like icons and windows, rather than 

text commands; over the years, Microsoft has released numerous versions of Windows, with some 

of the most notable being Windows 3.1 (early popular version), Windows 95 (introduced the Start 

button and taskbar), Windows XP (widely used for a long period), Windows 7 (popular for its 

stability), Windows 10 (current standard version), and the most recent, Windows 11; each version 

usually includes improvements in features, performance, and security compared to its 

predecessors.  

Key points about different Windows versions: 

 Early Windows (Windows 1, 2, 3.0): 

These early versions were considered basic with a less intuitive interface and were primarily 

used for basic tasks.  

 Windows 3.1: 

Considered a breakthrough, introducing a more user-friendly interface with features like 

improved icons, TrueType fonts, and popular games like Minesweeper.  

 Windows 95: 

A major milestone, bringing the iconic Start button, taskbar, and improved multimedia 

capabilities.  

 Windows XP: 

A widely adopted version known for its stability and user-friendly design.  

 



 Windows Vista: 

Introduced new visual effects but faced criticism for performance issues.  

 Windows 7: 

Considered a significant improvement over Vista with a refined interface and better 

performance.  

 Windows 8: 

Introduced a touch-centric interface with a tile-based design, which was not universally liked.  

 Windows 10: 

A significant update with a mix of classic and modern features, designed for consistency across 

devices.  

 Windows 11: 

The latest version, featuring a redesigned interface, improved security, and support for newer 

hardware.  

3.2 BASIC COMPUTER 

BASIC COMPUTER A computer is an electronic machine that can store, retrieve, and process 

data. It can perform a range of tasks, from simple calculations to complex simulations.  

How does a computer work?  

 Input: A computer collects data and instructions from the user. 

 Process: A computer processes the data according to the instructions. 

 Output: A computer produces the results on output devices. 



What are the parts of a computer?  

 Central Processing Unit (CPU): The brain of the computer 

 Memory: Stores data 

 Storage devices: Stores data 

 Input/output devices: Collects data and produces results 

 Peripherals: Other components that help the computer function 

What are some basic computer operations? inputting, processing, outputting, storing, and 

controlling.  

How are computers used? 

Computers are used for many tasks, such as:  

 Typing documents 

 Sending emails 

 Playing games 

 Browsing the internet 

 Creating presentations 

 Listening to music 

 Watching videos 

 

 

 



3.3 USES OF COMPUTER KEYBOARD  

To use a computer keyboard, you can press keys to enter text and perform other 

functions. You can also use keyboard shortcuts to perform tasks like highlighting text and opening 

programs.  

How to type  

 Position your keyboard at elbow level 

 Type with your wrists straight and a light touch 

 Avoid resting your palms on the keyboard 

 Take breaks from typing every 15–20 minutes 

How to use keyboard shortcuts  

 To highlight all text, press Ctrl + A on Windows or Command + A on Apple 

 To highlight a word, press and hold Shift + Ctrl and then press the left or right arrow 

 To delete highlighted text, press Del 

How to use function keys  

 F1: Opens the help screen 

 F2: Renames something 

 F3: Searches for something 

 F4: Closes something 

 F5: Refreshes something 

 F6: Opens the address bar 



 F7: Opens the spell checker 

How to type special characters  

 Press Alt and then a 3 or 4 digit number on the numeric keypad 

 

3.4  basic computer program 

A basic computer program is a set of instructions written in a programming language that tells a 

computer how to perform a specific task, usually designed to be simple and straightforward, often 

using a beginner-friendly language like BASIC, allowing users to learn fundamental programming 

concepts by creating small, functional programs.  

Key points about basic computer programs: 

 Simple syntax: 

They utilize basic commands and structures, making them easier to understand and write 

compared to complex programs.  

 Beginner-friendly: 

Languages like BASIC are often used as they are specifically designed for new programmers to 

learn the core concepts of coding.  

 Common functionalities: 

Basic programs can perform tasks like simple calculations, displaying text on the screen, taking 

user input, making basic decisions based on conditions, and repeating actions with loops.   

 Example tasks: 



Calculating a person's age based on their birth year, displaying a "Hello World" message, or 

creating a basic calculator.  

Important aspects of a basic computer program: 

 Variables: Placeholders to store data like numbers or text.  

 Operators: Symbols used to perform operations like addition, subtraction, comparison.  

 Conditional statements: Instructions that execute based on whether a condition is true or false 

(e.g., "if" statements)  

 Loops: Repeating a block of code multiple times based on a condition (e.g., "for" loops)  

  



CHAPTER FOUR 

HOW TO USE UPS  

An uninterruptible power supply (UPS) is a device that protects computers from power outages 

and other power issues. It can also help prevent data loss.  

How a UPS helps computers 

 Backup power: A UPS provides temporary power when there is a power outage.  

 Protection from power disturbances: A UPS can protect against power spikes, brownouts, and 

other electrical issues.  

 Line conditioning: A UPS can smooth out noisy power sources.  

 Data protection: A UPS can help prevent data loss or corruption during a power outage.  

 Business continuity: A UPS can ensure that networks and applications are available and avoid 

downtime.  

Where UPSs are used 

UPSs are used to protect a variety of electrical equipment, including computers, servers, hospital 

equipment, and data center equipment.  

UPS features 

Some UPSs have Automatic Voltage Regulation (AVR) technology that monitors and adjusts 

incoming voltage levels.  

  



4.2  Microsoft Word is a program 

Microsoft Word is a program that lets you create, edit, and format documents. You can use it to 

write letters, reports, resumes, and more.  

Getting started  

1. Open the Start menu 

2. Find and click Word in the list of applications 

3. If this is your first time using Word, you might need to agree to the Microsoft Software License 

Agreement 

Creating a document  

1. Select File > New 

2. Choose a template or start with a blank document 

3. Click on the new page and type your text 

Formatting  

1. Highlight your text 

2. Select the Home tab 

3. Choose formatting options like bold, italic, bullets, and numbering 

Adding media  

1. Select the Insert tab 

2. Add images, symbols, tables, or charts to your document 

Saving and opening 



1. Select File to open, save, or start documents  

2. You can find a list of your recently used documents in the left column when you start Word  

Learning more 

 You can try a learning guide like "Welcome to Word" or "Insert your first table of contents"  

 You can take a free course to learn more about Microsoft Word  

4.3 HOW TO USE A PHOTOCOPY MACHINE,  

1. Turn it on: Locate the power button and turn it on.  

2. Wait for it to warm up: Many photocopiers need a few minutes to warm up.  

3. Load paper: Check that the correct size paper is loaded into the machine.  

4. Prepare the document: Place the document face down on the glass.  

5. Check the glass: Make sure the glass is clean and free of marks.  

6. Select options: Choose the number of copies, paper size, and other options.  

7. Start copying: Press the Start button.  

8. Collect copies: Retrieve your copies from the output tray.  

9. Leave the machine as you found it: Remove the original and leave the machine ready for the 

next user.  

You can consult your photocopy machine's user manual for more specific instructions.  

  





CHAPTER FIVE 

5.0 RECOMMENDATION AND CONCLUSION 

5.1 RECOMMENDATION 

 I use this means to make the following recommendations concerning the training of 

students in Industrial Attachments 

i. I would like to recommend that the Engineering curriculum in the Polytechnics to adjust 

such as would provide going on industrial attachments for a longer period of time as opposed 

to 4 months or making the program to occur twice throughout an engineering degree 

program.  

ii. Allowances should be paid to students during their programme just like NYSC and not after. 

This would help them a great deal to handle some financial problems during their training 

course. 

iii. The SIWES coordinator and the polytechnic authority should try to stop the habit of rejecting 

students for SIWES program by the industries 

iv. The institution supervisor should make it a priority to visit their designated students in the 

various organization to update the student’s logbook 

v. Adequate space part should make available to save equipment from deplore condition. 

vi. More machines should be made available 

vii. Visiting of students during the SIWES program should be ensured by the Industrial Training 

Fund officials and college coordinators in order to ensure that students get necessary 

exposure and to boost their morale. 

 5.2 CONCLUSION 

 My 6months SIWES program was a huge success and a great time of acquisition of 

knowledge and skills. Through my training I was able to appreciate my chosen course of study 

even more, because I had the opportunity to blend the theoretical knowledge acquired from school 

with the practical hands-on application of knowledge gained here to perform very important tasks 

that contributed in a way to my productivity in the company. My training here has given me a 

broader view to the importance and relevance of banking and finance in the immediate society and 



the world as a whole, as I now look forward to impacting it positively after graduation. I have also 

been able to improve my communication and presentation skills and thereby developed good 

relationship with my fellow colleagues at work. I have also been able to appreciate the connection 

between my course of study and other disciplines in producing a successful result. 

 The Student Industrial Work Experience Scheme (SIWES) is an interesting program that 

adds more value to students view and objectives of their fields of study. 

 The Student Industrial Work Experience Scheme (SIWES) has made a great impact in the 

life of every student that diligently and faithfully participated in the exercise, as a matter of fact, I 

particularly I’m living testimony to the training. 

 I hereby encourage and advice every student to be committed to the training scheme, 

having it in mind that the journey of a thousand miles begins with a footstep. 
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